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Istra Camping Resort 5*

General Plan

TEMATIC BEACH - PIRATES
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Sanitary unit 1 + playground
Sanitary unit 2 + playground
Sanitary unit 3 + playground
Sanitary unit 4 + playground

Pizza / Pasta Grano Duro in the
shopping mall

Mezzino in the Aquapark

Tuna Bay Grill

Trattoria La Pentola

Sundance beach club

Beach Restaurant and Sky Bar

Lobby bar, Wine bar and restaurant,
Pool/wellness bar

Pirate Beach club

Water park

Water sport 1 ( speed boat, motor
boat, parafly, jet ski, Trimaran, Sailing)
+ Towel bar

Moorings

Land sports (Beach volley, adventure
golf, multipurpose playground, paddle
tennis, trim zone ...)

Water sport 2 (kayak, waterbike, sup,
windsurfing...) + Towel bar

Resort Beach

Resort Beach

Adult beach

Resort beach

Tematic Resort beach + beach bar

(Pirates)

Family beach

Teens club

Maro full concept + Playground XL,
Family indoor entertainment area
Playground L

Playground M

Shopping area zone ~Arcade style
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Istra Camplng Resort 5* Designer proposal

Ljitjana Curéija
Pitches P1
Sanitary units 1 & 2

Natali Zulijani
Tuna bay gril

FERORT MRS M AO-

TBD
Main road, Resort

Utility, Infrastructure
Poweyr, water, sewage, wi-fi,
survelllance

TISSA

GV

MH1

Trattoria La Pentola Roce \ : & -' .
Sundance beach bar beach el . : k : Studio 92 + Bezdikian
All beaches bi L ‘ea-raciit Central Area Facility,
Waterfront walking Entrance and Parking

ANTON
Pitches P2
Sanitary units 3 & 4

ST e MM

IG “‘ Pirate beach bar
All beaches (Maritime S RO

Domain) —. g nyingor?
Moorings - »

TAMATIC BLADN - PATES

ZDL
MH2 Zone

Natali Zulijani
Pirate beach bar g:rach restaurant & Sky
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Sudionici

® © arhitektonskih ureda
+ suradnici

® 1 inZenjerski ured (promet i infrastruktura)
+ suradnici

® investitor
® project manager

® BIM manager
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INVESTITOR
VALAMAR

PROJEKT
MANAGER
(IGH)

BIM MANAGER
(3D ART)

Marin Racic, dipl.ing.arh., 3D ART d.o.0., Rijeka

PROJEKTANTI
PERACTO
TISSA
CURCIJA
STUDIO 92
ZDL

ANTON
ARTITURA

PROJEKTANTI
INSTALACIJA
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Ciljevi

® smanjenje troskova i VTR-ova

integrirani BIM model

® uskladeni projekti: koordinirani elementi u BIM modelu
(prometnice+infrastruktura, granice medu
projektantskim obuhvatima)

® samostalnost u radu svakog projektanta uz moguénost
stalne koordinacije s ostalim kolegama

® moguénost pregleda od strane investitora
geometrija

kolicine

vizure

zasjenjenje

Marin Ragié, dipl.ing.arh., 3D ART d.0.0., Rijeka HKIG - Opatija 2019. 222 10



Priprema i planiranje BIM
implementacije
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BIM execution plan

CILJEVE | NACINI
UPORABE BIM-a

BIM PROCESI

RAZMJENA PODATAKA

INFRASTRUKTURA

Marin Racic, dipl.ing.arh., 3D ART d.o.0., Rijeka

Definirati znaCajke projekta i tima kroz
identifikaciju ciljeva i uporabe BIM-a

Definirati procese koji ukljucuju BIM i
razmjenu podataka

Razviti informacijske sadrzaje, “level of
definition” i zaduzenja clanova tima za
svaki sadrzaj

Definirati potrebnu projektnu
infrastrukturu za podrsku BIM procesu

BIM
PROJECT
EXECUTION
PLAN

=
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Rokovi

ldejni projekti Glavni projekti lzvedbeni projekti

BIMcloud setup BIM implementacija

izrada projekta na

P d . L |
“Klasiéan nadin” integrirani BIM model, samo 1 faza!
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Istra Camping Resort 5* Designer proposal

AutoCAD
Natali Zulijani =l f e AutoCAD

e ani units . .
SRS ArchiCAD (SU1) - pilot

Allplan, Civil 3D, projekt
ISScad, DDS CAD

TBD
Main road, Resort

Utility, Infrastructure
Power, water, sewage, wi-f,
survelllance

LIUR Ot
WATER ROy

ArchiCAD

- ...‘ '.. - ‘ :
TISSA % P8 i
GV 0 & ?"o....

: o,: > . e
MH1 7 i .: = -:::n..’
Trattoria La Pentola Rgce i o2 ~ AT =
Sundance beach bar beach e > —— & 3 . srea X Sevsus o H Studio 92 + Bezdikian
All beaches S 5% 2 "_., - e =1 "m' v o Central Area Fadmy.
Waterfront walking - Y apan Entrance and Parking
Waterfront walking ey e : . ™ s’ A uto CA D y
AUIOEAD — ' ArchiCAD
ANTON N .,
Pitches P2 -
Sanitary units 3 & 4 ( Skoro pIIOt
SEMOAT Ms MACM projekt)
| ®
IG “’ Pirate beach bar "
All beaches (Maritime S i 5l
Domain) =, ) MATER por
Moorings ‘ ..
ZDL
Natali Zulijani septed
ata an
Shrate basch bar g::r-)ch restaurant & Sky
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BIM ekosistem

4 S
dwg —  BIM modeliranje i unos BIM Data
Xls — informacija Management
.d;);: —. | (BIM authoring tool) h
P
.ifc : BIMC'OUd
skp ARCHICAD Y,

.

p
BIM pristup podacima
BIMX ((
iOS, Android ‘
.
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Kako raditi?
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LEVEL OF B”\/]:OF\)UM

DEVELOPMENT
SPECIFICATION

October 19, 2016

Milestones/Deliverables

Model SD DD CcD Constr Fabrication
Elements Coord
12
§
4
(0]
g
3
@
PARTICIPATING ORGANIZATIONS .
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Level of Devalcoment Specfication wwew. imforum.crgdlod Level of Development Specfication www.oimforum.crgllod

Version: 2016 Version: 2016
Uniformat  Omniclass Uniformat  Omniclass
ADD Element maodeling to include: 350 Element modeling to include:
»  Waterproofing « Actual elevabons and location of member connections
= Coursing = Main elements of typical connectons applied to all
»  Reinforcing structural steel connecbions such as base plates, gusset
plates, anchor rods, etc.
*  Any miscallanecus steel members with correct
orientation
*  Any steel structure reinforcement such as wed
B1010.10.30 21-02 101010 30 Floor Structural Frame {Steel Framing Columns) 51jf¥anar5. sleeve penetrations, etc.
Aassocieted Masterformat Sechona: 05 10 00
100 Generic calumn slement, S22 B0, 30 81010.10-LOD-350 Floor Structural Frame (Stes!
. raming Columns)
400 Element modeling to include:
«  Welds
« Coping of members
« Cappates
« Washers, nuts, etc.
«  All asseambly elements
27 81070 T O-LOD- 100 Floor Structural Frams (Stes!
Framing Columns)
200 Sea B101010 .
31 B10710.10-LOD-400 Floar Structurs! Frame [Stesl
Framing Columns)
28 B1010.10-LOD-200 Floor Structural Frame (S B1010.10.40 21-02101010 40 Floor Structural Frame (Steel Framing Beams)
Framing Columns) ] Asscciated Masterformat Sections: 051000 / 052000 / 0521 23
300 Elamant modaling to include: 100 See B10
= Spedfic sizes of main verical sfructural memioers
rrdeled per defined structaral grid with correct location 200 See 31010
and crientabion 300 Element modeling to include:
« Specfic sizes of main horizontal structural members

madeled per defined structural grid with correct
orientation, slope and elevation

20 51040 10-LOD-300 Floor Strueturs! Frame (Staal

Framing Columins) .
32 B10710.10-LOD-300 Floar Structurs! Frame [Stesl
Framing Beams)
Reference Part Il Attribute Tables for nen-graphical infermation Reference Part Il Attribute Tables for non-graphical information
Back bo TOC Capyrighl © 2016 by BIMFomm. Al rights reserved Az Back to TCC Capyrighl © 2016 by BIMForumr. Al rights reserved A3
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Modelirati Iscrtati i . -
Podaci . . Model izvedenog stanja
elf::ar.r;;nt el?szE]:nt (specifikacije) Izvedbeni projekt (as-built) Napomene
DA/NE DA/NE DA/NE LOD MEA, LOD MEA
A1010 | Tipsko temeljenje
Temel)i zidova | stupova DA DA DA 300 arhitektura 300 arhitektura
Temeljni zidovi DA DA DA 300 arhitektura 300 arhitektura
Temeljne grede DA DA DA 300 arhitektura 300 arhitektura
Temel] Sipova DA DA DA 300 arhitektura 300 arhitektura
Iskop, nasipanje | nabijanje zemlje MNE DA MNE - arhitektura - arhitektura
Temeljne stope DA DA DA =300 arhitektura 300 arhitektura
lzolacija temeljnog korita MNE DA MNE - arhitektura - arhitektura
Drenaza objekta MNE DA MNE - arhitektura arhitektura
Anker-plocice, vijci za sidrenje MNE MNE MNE - - -
Planiranje gradenja {izvedba/planiranje/radionicka dokumentacija) - - - - -
A1020 |Specijalni temelji
Piloti DA DA DA 300 arhitektura 300 arhitektura
Temeljne grede DA DA DA =300 arhitektura 300 arhitektura
Kesoni DA DA DA 300 arhitektura 300 arhitektura
Podupiranja temelja MNE DA MNE - konstrukcija - konstrukcija
Odvodnja MNE DA MNE - hidro - hidro
Rubne grede [ocjacanja) temeljnih ploca DA DA DA 300 arhitektura 300 arhitektura
Injektiranje MNE MNE MNE - konstrukeija - konstrukcija
Ostali specijalni temelji DA DA DA 300 arhitektura 300 arhitektura
Planiranje gradenja {izvedba/planiranje/radionicka dokumentacija) - - - - - - -
AT030[Ploce natlu
Podna ploca DA DA DA 300 arhitektura 300 arhitektura
Temeljna ploca DA DA DA 300 arhitektura 300 arhitektura
Temeljna ploca u nagibu DA DA DA 300 arhitektura 300 arhitektura
Hovowi, iskopi 1 tamponski sloj DA DA DA 300 arhitektura 300 arhitektura
Drenaza i izolacija ispod podne ploGe DA DA DA 300 arhitektura =00 arhitektura
Planiranje gradenja {izvedba/planiranje/radionicka dokumentacija) - - - - - - -
A2010 |Iskop podruma
Iskop za podrumske etaze MNE MNE MNE - arhitektura arhitektura
Masipanje | nabijanje zemlje MNE DA MNE - arhitektura arhitektura
Razupiranje MNE MNE MNE - konstrukeija konstrukeija
Planiranje gradenja {izvedba/planiranje/radionicka dokumentacija) - - - - - -
AZ020 [Podrumski zidovi
Mosiva konstrukeija podrumskog zida DA DA DA 300 arhitektura 300 arhitektura
Hidroizolacija podrumskih zidova MNE DA MNE - arhitektura - arhitektura
Toplinska izolacija podrumskog zida MNE DA MNE - arhitektura arhitektura
Unutarnja obloga [interijerska) MNE DA MNE - arhitektura arhitektura
Planiranje gradenja {izvedba/planiranje/radionicka dokumentacija) - - - - - -
B OVOINICA
B1010|Medukatne konstrukcija
Mosiva konstrukcija podrumske ploce DA DA DA 300 arhitektura 300 arhitektura
Mosiva konstrukcija medukatne konstukcije DA DA DA 300 arhitektura 300 arhitektura
Mosiva konstrukcija ploce balkona DA DA DA 300 arhitektura 300 arhitektura
Rampe DA DA DA 300 arhitektura 300 arhitektura
anjska stubista i evakuacijski izlazi DA DA DA 300 arhitektura 300 arhitektura
Uzdignuti montazni podovi (kompjuterski podovi) MNE DA MNE - elektro - elektro
Ostali elementi medukatnih konstrukcija i podova DA DA DA 300 arhitektura Ukoliko je potrebno.
Planiranje gradenja (izvedba/planiranje/radionicka dokumentacija) - - - - - -
B1020|Krovna konstrukcija
Konstrukeija ravnog krova DA DA DA 300 arhitektura 300 arhitektura
Konstrukeija kosog krova DA DA DA 300 arhitektura 300 arhitektura
MadstreEnice, tende, brisole]i DA DA DA 300 arhitektura 300 arhitektura
Ostali krovni sustavi DA DA arhitektura Ukaoliko je potrebno.

Planiranje gradenja {izvedba/planiranje/radionicka dokumentacija)

DA

300

arhitektura

300
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LEVEL OF DETAIL

LEVEL OF DEFINITION

i//'

LEVEL OF INFORMATION

Proces modeliranja elementa
Dimenzioniranje, materijalizacija i
postavka gradevinskih elemenata

Grafiéki prikaz elementa
Odabir naéina grafickog prikaza u
2D nacrtima i 3D prikazu

Vizualizacija elementa
Formiranje vizualnog identiteta

Unos informacija u ArchiCadu

- 1D oznaka

- klasifikacija elementa prema tipu
[Element classification)

- klasifikacija prema funkeiji nosivosti
[Structural funection)

- klasifikacija prema poziciji
relevantnoj za fiziku zgrade (opna ili
interijer) (Position)

- klasifikacija prema klasi

Proces modeliranja elementa
Dimenzioniranje | postavka
namjestaja i opreme

Grafiéki prikaz elementa
Tipoloski nadin prikaza namjestaja i
opreme u 20 nacrtima, stavkama i

Unos informacija u ArchiCadu

- 1D oznaka

- klasifikacija elementa prema tipu
(Element classification)

- klasifikacija prema funkciji nosivosti
(Structural function)

- klasifikacija prema poziciji

vizualizacija.

KOMNSTRUKTIVNI . . . .
DIO tgradetmlh eln.enjenata (u smislu boje va.troot;fornﬂstl -
i ostalih zavrénih obrada) u pregledu | (Fire resistance rating)
i izradi vizualizacija. - odabir layera
Obrada informacija u ArchiCadu
-izraduni koliéina
[Component schedule)
= , .. .
E Unos informacija u online Google
= tablice
E - tablica Popis slojeva
5 Proces modeliranja elementa Unos informacija u ArchiCadu
S Dimenzioniranje | postavka otvora - 1D oznaka
g - klasifikacija elementa prema tipu
g Grafiéki prikaz elementa [Element classification)
o Odabir nagina grafickog prikaza u - klasifikacija prema poziciji
2D nacrtima, stavkama i 3D prikazu relevantnoj za fiziku zgrade (opna ili
interijer) (Position)
Vizualizacija objekta - klasifikacija prema klasi
OTVORI Formiranje vizualnog identiteta vatrootpornosti
(STAVKE) otvora u pregledu i izradi [Fire resistance rating)

- kategorija stavke (stolarska,
bravarska, staklarska)

Obrada informacija u ArchiCadu
- izraduni koliéina (Schedules)

Unos informacija u Google tablice
- tablica Popis stavki

Marin Raci¢, dipl.ing.arh., 3D ART d.o.0., Rijeka

investitora.

Vizualizacija objekta

Genericki vizualni identitet zelenila u
pregledu i izradi vizualizacija.
Varijacije prikaza prema zahtjevu
investitora.

u 3D prikazu (predefinirano od strane relevantnoj za fiziku zgrade (opna ili
E BIM koordinatora) interijer) (Position)
E OPREMA (FF&E) - kategorija namjestaja opreme
E Vizualizacija objekta [namjestaj, sanitarna oprema, tehnika
(=] Genericki vizualni identitet opreme itcd)
u pregledu i izradi vizualizacija. - odabir layera
Obrada informacija u ArchiCadu
- izradéuni koligina
Unos informacija u Google tablice
- tablica Popis opreme
Proces modeliranja elementa Unos informacija u ArchiCadu
- klasifikacija elementa prema tipu
Mehilne kudice / glamping jedinice [Element classification)
modelira projektant prema - odabir layera
dimenzijama i specifikacijama
proizvodaéa odabranog tipa. Za Mobilne kucdice jos:
Kucica [ jedinica se sprema kao - klasifikacija prema tipu kucice
ArchiCAD objekt | koristi kao tipski (Mobile homes)
element. - klasifikacija prema podtipu kudice
[(Mobile homes - podtip)
MOBILE HOMES | Vizualizacija objekta - klasifikacija prema orijentaciji
/ GLAMPING [Orientation)
Svakome objektu odrediti genericki
vizualni identitet. Za Glamping
- Kod mobilnih kuéica bira se boja - klasifikacija prema tipu jedinice
E fasade unutar samog ArchiCAD (Glamping)
E objekta, prema RAL tonu po izboru - klasifikacija prema podtipu jedinice
w projektanta. (Glamping - podtip)
[F7]
5 Obrada informacija u ArchiCadu
o - tabela koliéina jedinica i specifikacija
E po tipu, | ostalim kriterijima
a
Proces modeliranja elementa Unos informacija u ArchiCadu
Postavka objekata postojeceq i - klasifikacija zelenila prema tipu
novog zelenila na taénu poziciju. [Element classification)
- klasifikacija prema tipu stabla
Graficki prikaz elementa - unos taénog broja stabala
Tipologki nadin prikaza zelenila. - renovation status
ZELENILO Varijacije prikaza prema zahtjevu - odabir layera

Obrada informacija u ArchiCadu
- tabela koliéina stabala | specifikacija
po tipu, i ostalim kriterijima

HKIG — Opatija 2019. g 23
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LOI

01-CH-05 Stolica

KATEGORIIA

01 | —
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SIFRA STAVEE

CH

REDNI BROJ

05
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<

arhiviranje dokumentacije
(PDF)

2D nacrti (DWG)
niblioteke (LCF)
notlink moduli
IFC

razine pristupa

Marin Racic, dipl.ing.arh., 3D ART d.o.0., Rijeka

® 0l
® multi-user



VALAMAR URED

Internet

—  TISSAURED —

—
]
B

— CURCIJAURED —

e O

BiMeloud

BiMoo) B
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L

— ZDL URED —

=

— STUDIO 92 URED —

2

— 3D ARTURED —

— AGENOR, PAUN —

i

&

&

&
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® 0@ /. vwsBm-BMoows20 ¥ | 4

€ | (O & 10.1.0.63:20000/#module:project-managerdid: DB25025C-74C2-AA48-B4C3- 37 DECBBBD4D( 0% - 0 . Q 0 ¢ A 4 §j¢ 9 =

Home Projects + > Funtana Settings

v B ShowAll - Q
D Funtana ¥ OB - P

) Projects 0 LT Backups  Activities Access

[ create folder ® Move o Settings
v [ Funtana MASTER & Oucae & tmport Name  Funtana
Funtana - Master Defauit Host Server(s)
L (7 Export

vig Not available
& MR- Main Road with infrastructure

U ODelete v1S  Not avallable

[ obuhvat Anton v20:  VALABIM-v20 (Inherited)

» [) Obuhvat Curcija P
Modified: 2017.11.14, 15:14

» ) o12ona

» [ 02 Zona - modul

» [ 03 Zgrade

» [ o4 Zgrade - modul

[ obuhvat Peracto

¥ [ Obuhvat Studio 92

» ) o12Zona

* [ 02 Zona - modul

» ) 03 2Zgrade

» [ 04 Zgrade - modul
v [ Obuhvat Tissa

» [ 012Zona

» [ 02 Zona - modul

» [ 03 Zgrade

» [ 04 Zgrade - modul

v [ Obuhvat ZDL

» [0 o12Zona
» [ 02 Zona - modul 3
» [ 03 zgrade 4

» [ 04 Zgrade - modul
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BIM MANAGER, BIM KOORDINATORI

(3D ART)

PROJEKTANTI, MEP CENTRALNE ZONE
(PERACTO, TISSA, CURCIJA, STUDIO 92, ZDL, ANTON, ARTITURA , AGENOR, TERMOTEHNIKA PAUN

KLLIENT
(VALAMAR)
PROJECT MANAGER
(IGH])
]
]
]
]
]
]
]
objekn
1
]
objekt
1
]
objekt
1
]
MASTER FILE sl
]
objekil
1
]
objekil
]
]
ohjekil
]
]
]
]
]
]
]
]
]
]
VIZUALIZACIIA 1
T ]
" ]
- ]
L 1
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DWG
ZONA 1 |«—8AMWaK | 70N A 1 modul
ZONA 2 |« 'CaMWek | 70NA 2 modul
ZONA 3 |« 1S2MWerk | 70NA 3 modul
ZONA 4 |«—83MWAK | 70N A 4 modul
ZONAS |« '8aMWerk | 70NA 5 modul
ZONA 6 |«—22MWark | 70NA 6 modul
ZONA7 | t82MWerk | 70NA 7 modul
- Layouti - 3D terena cijele zone
- Presjeci - zgrade kao objekti
- Fasade - kote
- Tablice - nznake (label)
- Situacija cijele - radni presjeci
Fane - radne tablice

DOKUMENTACIJA

MODEL

¢ Layouti
i Presjeci za print
- Fasade

:- Tablice

VALAMAR

IDOKUMENTACLIA

teamwork

teamwork

teamwork

ZGRADA 1 modul

ZGRADA 2 modul

ZGRADA 3 modul

- 3D modeliranje
- kote

- oznake (label)

- radni presjeci

- radne tablice
(kali¢ine)

MODEL

E ARCHICAD - BlMeloud {TeamWork)

| |
1
1 1 BIMx
1
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BIM procedure
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Priprema

® ArchiCAD template
® Dropbox struktura

® Upute za projektante

Marin Racic, dipl.ing.arh., 3D ART d.o.0., Rijeka



Fens & Colors

ArchiCAD template

® Opéa podedavanja
® Geometrijai 2D prikaz

Attributes of the current project: Funtana - Master

Current Pen Set:

# N R

221 [] 255
22z [ 124
223 I 78
224 [[] 255
225 [] 127
26 [ ©

=27 W ©

22 [ ] 23z
22 [ ] 255
zan [] 1e7
231 [ 165
zaz [ 145
233 [ ] 255
za4 [ 127
zas I ©

2a6 [ ] 255

G

235
165
127
191
223
127
63
232
235
191
103
165
235
127
127
191

001 print 1:100

<

B Description

127 Camping plots standard
81 Comfort

63 Comfort Mare

127
255
255
127
232
255 MH Premium

255 MH Vertical

g1 MH Couple

&1 MH Thematic village
255
255
255
127

Mega Comfort
Premium Mare
Luxury Mare
Mega Luxury Mare
user defined

MH Premium za invalide
MH Premium Family
MH Premium Mare

MH Premium Villa
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0.15
0.15
0.15
0.15
0.15
0.15
0.15
0.00
0.15
0.15
0.15
0.15
0.15
0.15
0.15
0.15

: Mast-- D=
i i Fh = i AT fu
Element Element Element sa GR AB greda Hiadniak o K Idejno - kota
garniture garniture ugaocni sudoperom 20x40 cm adnja oznara visinska
A A s = A =
_ +——+ ~
- - _ KR AB 20 cm, KR AB 20 cm,
Kosa ploéa Kota - kutna Kota - linijska Kota - radijalna  Kota - visinska kosi krov - crij... ravni krov, pro...
.. - o -
. WMo = [ [ . o
Liniiski presiek MK AB 16 cm, MK AB 20 cm, Meto zona - Meto zona - Oplate - Ormar -
1 presi pod na tlu - k... medukatna - ... unutarnje zatv... vanjski natkriv... prevaljeni pre... dvakrilni

i N 0 i i f

Jum

i

- ' ) SP AB stup o . Stol za
Pearilica rublja Piscar 20x30 cm Stol - niski Stol - radni blagovaonicu Stelac
. Telewizor 55- Televizor 60- Televizor 65- . . Umivaconik
Stednjak inch inch inch Teren Urmivaecnik ugradbeni

WV 1-krilna
staklena vrata

W 1-krilna puna
vrata - kupao...

W 1-krilna puna
wvrata - ulazna

W 3-dijelna
staklena vanjs...

VP Oploéenje VZ AB 20 cm, VZ
betenske ploée  wanjski zid - et...

HKIG — Opatija 2019.
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ArchiCAD template

® |nformacije (tablice, property manager,
translatori)

O
Q

Mame

GENERAL RATINGS
Fire Resistance Rating
Combustible

Thermal Transmittance

Type

Option Set
True/False

Genaral

Sound Transmission Class General

FUNTANA INFO
Lekacija

Tip prestora

Flots

Kategorija opreme
Vrsta stavke
Mobile homes
Mobile homes - podtip
Glamping
Glamping - podtip
Orientation

Stabla

Broj postojecih stabala

Broj posjeéenih stabala

Broj preocstalih stabala

Option Set
Option Set
Option Set
Option Set
Option Set
Option Set
Option Set
Option Set
Option Set
Option Set
Option Set
Integer

Integer

Integer

Default

30 minutes
False
Undefined
25

Vanjski prostori
Matkriveni prostor
Medefinirano

01 Mamjestaj
Stolarija
Medefinirano
Medefinirano
Medefinirano
Medefinirano
Medefinirano

Medefinirano

Property Manager
" Editable: 1
Mame:

Maobile homes

¥ DEFINITION

Data Type: Option Set

v Medefinirano
Type A - Premium
Type B - Family

Preview/Default:

Description:

Type G - Couples
Type D - Side house
Type E - Premium Villa

v AVAILABILITY
Available for the following Element Classifications:
All Building Element Proxy

MNone

o Custom

Erlit
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ArchiCAD template
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v

¥

v

v

YYyYYYyyvw|

Y YYYYYVYYYYV|

-

YYYYYVvw|

TTT?T?TFTTTTT|

Dropbox

| 01 DOKUMENTACIJA
|1 01 Idegjni projekt

|| 02 Glavni projekt
|| 03 lzvedbeni projekt
|| 04 Vizualizacije

|| 05 BiMx

| | 06 IFC

| 02 RADNO BIM
|#55 00 BIM sistemn

|| Agenor
| | Anton

| | Artitura

[ Guréija
|| Dionaea

|| Peracto

|| Studio 92

| | Termotehnika Paun

| | Tissa

1 Z0L

| 03 INPUT
ORGANIZACIJA | TEMELJNI DOKUMENT! PROJEKTA
PODLOGE ZA PROJEKTIRANJE
ZAPISNICI SA SASTANAKA
ZADNJE PODLOGE PO ZONAMA
FACT SHEET OVERVIEW
| | 6. UPRAVNI POSTUPAK
| 04 SUDIONICI
] 3D Art

| | Agenor
| | Anton

] Artitura

[ Guréija
| | Dionaea

[ IGH

|| Peracto

[ Studio 92

| | Termotehnika Paun

| | Tissa

= 1.
| 2.
| 3.
[ 4.

| 5.

|| Valamar

] ZDL

Struktura

1 01 DOKUMENTACIJA
> 01 |dejni projekt
. 02 Glavni projekt
» [ Central zone
. F&B Points
.| CB - Craft Beer and Girill
| 00 ZADNJE
| 00 IFC
| 01 Arhitektura
| 02 Konstrukcija
03 Strojarstvo
| 04 Elektro
'| 05 voda | kanalizacija
| 06 elaborat zastite na radu
01 Arhitektura
| REV A 8.5.2017
| REV B datum
02 Konstrukcija
03 Strojarstvo
04 Elektro
05 voda i kanalizacija
| 06 elaborat zastite na radu
PB - Pirate beach club
| SB - Sundance beach club
.| TB - Tuna Bay Grill
| TS - Trattoria and Sky bar
Mobile homes
| Playgrounds
Plots
| Pools
Sanitary blocks
Storage
| Traffic Solution & beaches
| Water Sports
03 Izvedbeni projekt
| 04 Vizualizacije
05 BIMx
06 IFC

v

v

k4

v

A 4

YVYVYVYVYY V]

\

v

Yy vy Y wvYYy

vy Yy YUYy

Vi Vi V29 V¥

V'V V ¥V



22 Deleted files

Files

My files Need help restoring deleted files? Learn more

Sharing

File requests Name

Deleted files o Funtana - Master preklop B.ifc

Camping Resort [stra 2018 - ... - Master

mapa bez naziva
Camping Resort Istra 2018 » ... = 04 SUDIONICI

Model Element 4395lektro.gsm and 999 more files

elektro bibl

Scratch 2599941986
cesta
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Rjeenje za navedeni warning u Windowsu.
Warning!

Some Libraries could not be received,
y i;'_ because their local copies cannot be

overwritten.
u e Z a Note: This might be caused by multiple instances of
ARCHICAD using the same BiMcloud / BIM Server
Library.
. kt t

Skip Receive T

Otici na START, ukucati RUN i uci, ukucati REGEDIT da biste uili u Registry Editor.
Pratiti slede¢u putanju u registru:

Computer\HKEY_CURRENT_USER\Software\Graphisoft\ARCHICAD-64\ArchiCAD-64 20.0.0
INT R1\Teamwork

Sa desne strane potrebno je da naci fajl sa slike MaxInlinedBlobSize i promeniti mu broj

1024 u 2100000000 (21 sa 8 nula).
Ovo treba napraviti na svakom racunaru koji uestvuje u projektu.

‘ N O m e n k I a t u ra Nakon 3to ovo napravite potrebno je zatvoriti ArchhiCAD. Nakon sljedeceg pokretanja
programa trebalo bi da moZete imati viSe fajlova sa istom bibliotekom otvorenih u isto

vreme.
‘ . o Registry Editor
BIMcloud procesi e
Tracker A |1 Name Type Data
Unid-GUID Conversion XML File ab| ContactListUpdateinterval REG_SZ 10000
:’g::;;ccz:t::tu ab|DiscardinvalidPassword REG_SZ 1
9| Enablel ogReportSending REG_DWORD  0x00000000 (0)
4 \"4 . VBULil CheckControl
' R e S a Va n e B I IVI C I O u d Vertical Font Options ablForceSecureConnections REG_SZ 0
J J WorkEnvironment abHotlinkCacheCorrection REG_SZ 1
Write XML b HttpldleTimeOut REG_SZ 6000
o rver Configuration ab HttpProxyBypass REG_SZ localhost
u p O Z O r e n a rver Control Center 20| HetpProxyHost REG_SZ
J rver Manager ablHttpProxyPort REG_SZ 0
ab|HttpProxyType REG_SZ System
ure BIMcloud Manager ab] MailboxConnectionTimeout REG_SZ 30000
ure BIMcloud Server ab) MailboxSessionTimeout REG_SZ 30000
b MaximumNumberOfBugReports REG_SZ 10
ot = MaxinlinedBiob Size | REG_SZ A
LConverter ab] MemberPresenceCheckingSensibility REG_SZ 3
tension abProcessLoggerReportType REG_SZ 17
tPackageTool ab) ProxyServer REG_SZ 1
0gges 79/ Reserve External Drawing for Auto Update REG_DWORD  (x00000001 (1)
i b ServerPresenceCheckingSensibility REG_SZ 3
75| ShowPublishTask REG_DWORD  0x00000000 (0)
nition ab1SignalClientConnectionTimeout REG_SZ 30000
lia b1 TrustedCertificateFile REG_SZ
Y 11 @b TrustedCertificatesPath REG_SZ
< >

Computer\HKEY_CURRENT_USER\Software\Graphisoft\ArchiCAD-64\ArchiCAD-64 18.0.0 AUS R1\TeamWork
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Workflow

Projektanti BIM koordinatori Investitor

Marin Ragié, dipl.ing.arh., 3D ART d.0.0., Rijeka HKIG — Opatija 2019. g 38
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Projektanti

Modeliranje

|

Unos informacija

|

Tjedno azuriranje modela
(vidljivo investitoru)

|

Referenciranje

Marin Ragié, dipl.ing.arh., 3D ART d.0.0., Rijeka HKIG - Opatija 2019. 22 39
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Unos informa

CATEGORIES AND PROPERTIES

Element Classification:

ID AND CATEGORI
1w}

Structural Function
Position
RENOVATION

Renovation Status

Distribution Element

06-WC-XX

Interior

Existing

Show On Renovation Filter All Relevant Filters

FUNTAMA INFO

oad-Bearing Element

01 Namjestaj

Kategorija opremea 02 Sanitarna oprema u
IFC PROPERTIES 02 Sanitarna oprema
FC Tvpe 03 Oprema i uredaji
e 04 Tehnika
ARCHICAD IFC ID 05 Lake pregrade
Globalld {Attribute) 06 Rasvijeta
07 Urbana oprema
&> 031 Oprema - sanitarije, dimnjaci itd » Cancel “ 08 Interijerska oprema
1 08 Hidroinstalacije - oprema
10 Elektroinstalacije - oprema
11 Strojarske instalacije - oprema
Popis opreme.xlsx
File Edit WView Insert Format Data Tools Add-ons Help Last edit was 13 days ago
e o~ T 100% Kn % .0 .00 123 Arial 10 B 7 s A-<-H =E-1-|%-%- e [ v -3
A B D F G K L M N o]
! |
2 POPIS OPREME
3 SIFRA
POTVRDA | POTVRDA
. KTG gs. R.B. OPIS PROZVOBDAL MODEL FINALNA OBRADA DIMENZIJE SPEC. NAPOMENE UNIO ARHITEKTA | VALAMAR
-
6 NAMIJESTAJ
T -
] | Stolac v
metalne naturi
g 01 -~ ST ~ 001 fbarski metalni stolac GRATTONI GS 880 metalne crne mat h=74cm
baje Tl -

Marin Racic, dipl.ing.arh., 3D ART d.o.0., Rijeka
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Tjedno azuriranje modela

BIM MANAGER, BIM KOORDINATORI

(3D ART)

PROJEKTANTI, MEP CENTRALNE ZONE
(PERACTO, TISSA, CURCIJA, STUDIO 92, ZDL, ANTON, ARTITURA , AGENOR, TERMOTEHNIKA PAUN

KLIJENT
(VALAMAR)

PROJECT MANAGER
(IGH)

VIZUALIZACLIA

- Layouti

- Pregjeci

- Fasade

- Tablice

- Situacija cijele
zone

DOKUMENTACILIA

- 3D terena cijele zone
- zgrade kao objekti

- kote

- oznake (label)

- radni presjeci

- radne tablice

MODEL

- Layouti
- Presjeci za print
- Fasade
- Tablice

DOKUMENTACILJA

- 3D modeliranje
- kote

- oznake (label)

- radni presjeci

- radne tablice
(kaliGing)

MODEL

Funtana MASTER | obiekt 01ZONA | teamwork| 02 ZONA - modul | 0oPiekt | 03 ZGRADE | teamwork| 04 ZGRADE - modul
Mo moau
e BIMcloud struktura foldera f-----------cccmmmii e :

Marin Racic, dipl.ing.arh., 3D ART d.o.0., Rijeka
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Save as objekt

gsm

Library manager

l

DROPBOX
FOLDER
(za objekte)

Load falder

Create container

=]

Fi ArchiCAD
2 ZGRADE
=

£ ArchiCAD
1]

3 POMOCNI
=]

Fi ArchiCAD
< ZONE
T

def

Manage BIMcloud libraries

l

DROFPBOX
FOLDER
(za biblioteke)

|

Add BlMcloud library

Reload & Apply

Upload ili Update from

Marin Racic, dipl.ing.arh., 3D ART d.o.0., Rijeka

Shema unosa
objekata |
biblioteka na
BIMcloud
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ArchiCAD File > Libraries and Objects > Save selection as > Object (gsm)
ZGRADE Objekt se pravi iz prozora 3D aksonometrije
na BIMcloudu (ne top view, ne perspektiva)

*proces ponoviti sa svim zgradama u zoni

DROPBOX

FOLDER
(za objekte)

< Otvoriti prazan ArchiCAD lokalno, ne na BlIMcloudu Library

Library Manager > Add > Odabrati folder za objekte na Dropboxu > Reload & Apply

Za optimaciju 2D prikaza objekta:

Uéi u Objekte i postaviti objekt zgrade na tlocrt

File > Libraries and Objects > Open object

Oti¢i na 2D Symbol > editovati nain prikaza objekta u 2Du (brisanje nepotrebnih linija, postavljanje hotspotova)
CTRL S - saCuvati promjene, iza€i iz taba za editovanje objekta

Lokalni
ArchiCAD

*proces ponoviti sa svim objektima zgrada

Libraries and Objects > Create container > Odabrati uneti folder > Create (Icf)
Odabrati folder koji smo uneli sa Dropboxa

DROPBOX

FOLDER
(za biblioteke)

ArchiCAD Otvoriti ArchiCAD Zone na BIM cloudu

ZONE Libraries and Objects > Manage BIMcloud libraries > Upload ili Update from
na BIMcloudu

|

Library Manager > Add > Dodati biblioteku koja je prethodno dodata na BIMcloud > Reload & Apply

Upload kada se biblioteka prvi put dodaje na BIMcloud
Update from nada se postojeéa biblioteka dopunjava novim objektima

Marin Ragié, dipl.ing.arh., 3D ART d.0.0., Rijeka HKIG - Opatija 2019. 22
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Referenciranje

® Master model
® Hotlink modul
® Linkanje 2D DWG
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Workflow

BIM koordinatori (kontinuirani rad)

® Lomunikacija sa svim sudionicima projekta
® tehni¢ka podrika projektantima i investitoru

® Lontrola kvalitete

® |essons learned

Marin Ragi¢, dipl.ing.arh., 3D ART d.0.0., Rijeka HKIG - Opatija 2019. Z22Z 46



Tijek rada

BIM koordinatori (tjedni ciklus)

Koordinacija predaje

l

Unos instalacija

l

Kontrola individualnih modela

l

Kontrola Master modela (konflikti)

l

lzvoz IFC podloga

l

lzvjestavanje

Marin Racic, dipl.ing.arh., 3D ART d.o.0., Rijeka



Unos instalacija - infrastruktura
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Sent Message

& Ana Jevtic Kos

* 28.

06.2017. 11:15:13

Recipients:

Sla

Wian

Trifunovié

nedostaje

podzid

Closa

Apply View

Dielete

Sent Message

2  Ana Jevti¢c Kos
ﬁ 12.07.2017. 10:27:08

Recipients:

Slaven
Trifunovié

Plaza prelazi preko kruZznog toka i ceste.
Potrebno je ili izmodelovati cestu ukoliko je
deo vaseg projekt ili se pomeriti ukoliko nije.

Apply View

|
Close Delete |

] ~ "_‘i!n

it

Sent Message

A Ana Jevti¢c Kos
ﬁ 12.07.2017. 10:41:11

Recipients:

Slaven
Trifunovié

Instalacije plina "isplivavaju” iz projektovanog
nivoa terena. Proveriti kote sa Termotehnikom
Paun i koordinisati ove i sva sli€¢na mesta.

Apply View

Close Delete

!
1

.




Workflow

Investitor

Tjedni pregled modela

Komunikacija sa projektantima putem BlMclouda

spitivanje varijanti

Koordinacijski sastanci

Provjera kolicina

Marin Ragié, dipl.ing.arh., 3D ART d.0.0., Rijeka HKIG - Opatija 2019. Z22& 51
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Koordinacijski sastanci

Marin Raci€, _ﬁiplrﬂng.arh., 3D ART d.o0.0., Rijeka HKIG — Opatija 2019.
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Koordinacija putem BlMclouda

Received Message n

Received Message n SRS

Vanessa Fonovi¢
2.6.2017. 15:59:38

Vanessa Fonovic

2.6.2017. 15:57:42

Recipients: Recipients:

Lucia Peso Lucia Peso

Jeste li predvidjeli neku rasvjetu u ovom jos jedna stavr dodatno, je li ovo metalni okvir i
nenatkrivenom dijelu? unutra drvene lamele?

Ako niste, neito bi trebali tamo imati, npr. stojecu Jer ako je tako onda mislim da moramo

lampu ili sk

pojednostaviti konstrukciju ovo e biti pre glomazno
i skupo...7

Apply View Apply View

gReply | ‘ gReply




All Components Schedule

Mame | Full Element ID | Area [m2] | Volume [m3] | Element Classification | Skin Thickness
AB
MODUL Atributi 4,00 0,80 Slab 0,20
o VZXX 564,66 183,64 [Wal 0.30
P r V r VZXX 44,73 8,27  |Wal 0,20
WEXX 0,48 0,63 Wall 1,30
WEXX 50,97 6,78 Wall 0,15
postojeci zid 109,47 17,01 Wall 0,20
e \/ o postoject zid 314,02 80,47 Wall 0,30
1188,33 m< 297,60 m?
OliCINng LR
MODUL Atributi 4,00 0,60 Slab 0,15
MODUL Atributi 16,00 2,56 Slab 0,16
MODLUL Atributi 8,00 1,44 |Slab 0.18
MODUL Atributi 20,00 12,00 Slab 0,20
MODUL Atributi 4,00 0,88 Slab 0,22
MODUL Atributi 24,00 6,00 Slab 0,25
MODUL Atributi 21,20 3,68 Roof 0,20
MODUL Atributi 38,00 7,60 Wall 0,20
MODUL Atributi 7,60 1,80 Wall 0,25
MODUL Atrib... - 3,20 Column 0,30
WEKK 11,20 2,24 Wall 0,20
7i 152 0,92 |Beam 0.60
22 5,49 4,38 Beam 0,80
22 4,58 2,75 Beam 0,60
23 449,53 38,71 Beam 0,80
Zd 38,13 35,19 Beam 0,95
i 2,19 1,15 Beam 0,60
4 15,58 16,92 Beam 1,10
4 4,76 3,81 Beam 0,80
5 184,12 198,80 Beam 1,10
£5 1,75 1,56 Beam 0,95
75 224 169 |Beam 0.80
503,89 m* 347,98 m®

AB - vodonepropusni

MODUL Atributi 8,00 0,80 Slab 0,10
MODUL Atributi 28,00 4,20 Slab 0,15
MODUL Atributi 4,00 0,64 Slab 0,16
MODUL Atributi 8,00 2,00 Slab 0,25
MODUL Atributi 4,00 1,08 Slab 0,27
MODUL Atributi 4,00 1,20 Slab 0,30
MODUL Atributi 7,60 0,76 Wall 0,10
MODUL Atributi 7,60 1,14 Wall 0,15
MODUL Atributi 7,60 1,22 Wall 0,16
MODUL Atributi 38,00 7,60 Wall 0,20
MODUL Atributi 80,80 15,20 Wall 0,25
177,60 m 35,84 m
Beton - podlozni
MODUL Atributi 24,00 1,20 Slab 0,05
MODUL Atributi 4,00 032 Slab 0,08
MODUL Atributi 12,00 1,20 Slab 0,10
40,00 m° 2,02 m
Beton u padu
MODUL Atributi 8,00 0,32 Slab 0,04
MODUL Atributi 4,00 0,20 Slab 0,05
Marin Ragi¢, dipl.ing.arh., 3D ART d.0.0., Rijeka HKIG — Opatija 2019. Z22& 55
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Kraj projekta

Kontrola kvalitete

Konacni izvjestaj (individualni, zavrsni)
Analiza naucenih lekcija

Zakljucni sastanak

Faza Il - koristenje u izvedbi:
® izvodali

® nadzor
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Master model - BIMx
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Master model - BIMx

11:44

PO_FUNTANA_ GLAVNI PROJEKT - SADRZAJ

> »l o) 1:14:22/1:20:38 = g E O
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Hvalal :-)

b *\ inteligentno
(b 0 modeliranje
prostora
3d art - softver u arhitekturi d.o.o.
Ruziceva 21, Rijeka
Tel 051 586 381
www.3dart.hr

kontakt@3dart.hr
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